
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

BLUETOOTH Phone Base 
Advanced Edition 

 
 
 
 
 
 
 
 
 

USER’S GUIDE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

VERSION 1.11 
 
 
 
 

 
Bluetooth 

 
 
 

         

1

 
 
 
 



2

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

©  All rights 
reserved. 

All trade names are registered trademarks of respective manufacturers listed. 

The Bluetooth name and the Bluetooth trademarks are owned by Bluetooth SIG,Inc. 

This manual may not be copied in any media or form without the written consent of original maker. 



 
TABLE OF CONTENTS 

 
 

1. WELCOME ................................................................. 5 

1.1. FEATURES ..............................................................................6 

1.2. BEFORE YOU START ................................................................6 

1.3. GETTING TO KNOW YOUR BLUETOOTH PHONE BASE .................7 

2. BLUETOOTH PHONE BASE INSTALLATION ............................ 8 

2.1. HARDWARE INSTALLATION ......................................................8 

2.2. SOFTWARE INSTALLATION .......................................................8 

3. CONFIGURATING BLUETOOTH PHONE BASE.......................... 9 

3.1. CONFIGURE WITH PC UTILITY..................................................9 
3.1.1. Preparation ....................................................................................9 

3.1.2. Start Using PC Utility................................................................... 10 

3.1.3. View Settings ............................................................................... 10 

3.1.4. Change Settings ........................................................................... 11 

3.2. CONFIGURE WITH REGULAR TELEPHONE ................................ 17 
3.2.1. Preparation .................................................................................. 18 

3.2.2. Start Configuration...................................................................... 18 

3.2.3. After Configuration ..................................................................... 19 

4. USING BLUETOOTH PHONE BASE .....................................20 

4.1. USING WITH BLUETOOTH CTP HANDSET................................. 20 
4.1.1. Connect Phone Base .................................................................... 20 

4.1.2. Answer a call ............................................................................... 20 

4.1.3. Make a call ................................................................................... 20 

4.2. USING WITH BLUETOOTH HEADSET........................................ 20 
4.2.1. Pair with Headset ........................................................................ 21 

4.2.2. Answer a Call ............................................................................... 21 

4.2.3. Make a Call................................................................................... 21 

4.3. USING WITH BLUETOOTH HANDSFREE DEVICES ....................... 21 
4.3.1. Pair with Handsfree Device ........................................................ 22 

4.3.2. Answer a Call ............................................................................... 22 

4.3.3. Make a Call................................................................................... 22 

4.4. WHEN PHONE BASE IS PAIRED WITH TWO OR MORE DEVICES ... 23 

4.5. USING CALLING CARD............................................................ 23 

4.6. OPERATION MODE................................................................. 25 

5. TROUBLESHOOTING ....................................................26 

3



6. APPENDIX ................................................................27 

6.1. APPENDIX A.......................................................................... 27 
6.1.1. Install Widcomm Software .......................................................... 27 

6.1.2. My Bluetooth Place...................................................................... 30 

6.1.3. Connect the Bluetooth Virtual Com ........................................... 32 

6.2. APPENDIX B .......................................................................... 35 
 

4



 

 

1. WELCOME 
 

Thanks for your purchase of this Bluetooth Phone Base (advance 
edition).  

 
Bluetooth Phone Base can be connected to a Bluetooth Headset or 
Hands-free. It can also be connected to mobile phone, PDA, or 
smart phone that supports Bluetooth Cordless Telephony (Terminal 
role) or Handsfree (Hands-Free unit role) Bluetooth profile. In this 
manual, a “CTP handset” is referred to such mobile phone, PDA and 
smart phone. This allows you to make and receive calls freely in the 
building through fixed line or public switching telephone network 
(PSTN), as well as GSM/CDMA network.  
 
Phone Base bridges the gap between mobile devices and wired 
phone. It allows you to take advantage of the high voice quality and 
reliability and low cost of wired phone; at the same time, you can 
also enjoy the convenience of making/receiving calls through CTP 
handset such as talking on the move and retrieving contacts 
information inside the phone. 
 
Phone Base is the central hub connecting the CTP handset, PDA or 
Headset/Handsfree devices around it. It is similar to DECT or 
cordless phone base station but provides more.  

 
Phone Base has a build-in dialer function that a user presses one key 
to replace the long strings of access code and password in the 
calling cards.  It also supports call list (4 received/dialed/missed 
calls, totally 12 call numbers). In addition, Phone Base can detect 
the termination of the call and hang up the call automatically, just 
like what your mobile does. 
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1.1. FEATURES 
 
 

� Bluetooth specification V1.2 

� Bluetooth Class 1 RF output 

� Support Cordless Telephony Profile V1.1 (Gateway) 

� Support Bluetooth Hands-Free Profile V1.0 and Headset Profile V1.1 

(Audio Gateway). 

� Support public switching telephone network (PSTN) and most PBX/PABX 

� Support dual models of Caller ID: FSK and DTMF 

� Support dialer function and call waiting  

� Support multiple Bluetooth handsets and headsets 

� Configuration via telephone set or Bluetooth 
 
 

 

 

 

 

1.2. BEFORE YOU START 
 

Please confirm your box content first. 
 
 
 
 
 
 
 
 
Bluetooth      7.5V DC Power   Telephone   CD-ROM    Quick Start   
Phone Base    Adapter    Cord          Guide 
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1.3. GETTING TO KNOW YOUR BLUETOOTH PHONE BASE 

 The Front Side        The Back Side 

 

Mode Button 

BT Connection LED
(Blue)  

Mode / Status LED
(Orange) 

Power LED
(Green)  

Slide Switch 

C nnect to phone line
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C

� Mode Button: 

Push this button to change operation between Paring/Being 

paired/Configuration Mode. 

� Power LED (Green) 

Input Power indication.  

� Mode/status LED (Orange) 

 Mode/status indication.  

� Bluetooth Connection LED (Blue) 

Bluetooth connection/status indication.  

Please refer to Section 4.6 for more details. 

� Slider Switch 

Set the Slider Switch to Cfg. position only when you doing co

Otherwise, it shall be at Std. position. 
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o

.5V DC Power Jack

onnect to telephone

nfigurations. 



 
 

2. BLUETOOTH PHONE BASE INSTALLATION 
 

2.1. HARDWARE INSTALLATION 
� Connect the power adapter cord to the power jack. The base’s orange 

and blue indicators will flash once and green LED stays on. 

Note: If it’s your first time using Phone Base, the orange and blue LED 

will both flash that means Phone Base is waiting to be paired. Please 

refer to Section 4.6. 

� Unplug your telephone’s line from your telephone and plug into the 

base’s socket marked Line. 

� Use the supplied telephone cord to connect the Base’s phone jack 

marked Ext. and your telephone.  

 
 

2.2. SOFTWARE INSTALLATION 
 
 

The software: Phone Base Utility is used optionally for configuration of your 
Bluetooth Phone Base. 

 
 

It allows you to: 
 
� View/Change PIN code 

� View/Enter calling card number 

� View/Edit call lists 

� View/Delete the Bluetooth address of the paired devices 

� View/Change device name 

� View/Change parameters for dialing 

� Upgrade firmware 
 

You need to run Setup.exe in the directory Phone Base Configuration Utility 
to install the configuration utility from CD-ROM to your PC/Notebook. 

 

8



 
 

3. CONFIGURATING BLUETOOTH PHONE BASE 
 
 

Bluetooth Phone Base may need to be configured before they can 
be properly used.  
 
There are two ways to do configurations. 
� Configure with PC utility 

� Configure with regular telephone 
 
The first way is more complicated but provides more functionality.  
The second way is simpler and easier but provides less functionality. 
 

3.1. CONFIGURE WITH PC UTILITY 
 
You need a Bluetooth enabled PC or Notebook that has a Bluetooth virtual 
COM port to configure Phone Base.  
 
The configuration utility allows you to: 
 
� View/Change PIN code 

� View/Enter calling card number 

� View/Edit call lists 

� View/Delete the Bluetooth address of the paired devices 

� View/Change device name 

� View/Change parameters for dialing 

� Upgrade firmware 
 

3.1.1. Preparation 
 
 

� Connect Phone Base with Bluetooth virtual COM port on your 

PC/Notebook. 

Please refer to Appendix A for an example about how to connect and 

open Bluetooth virtual COM port using Widcomm software. 

� Launch the Phone Base Utility 
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3.1.2. Start Using PC Utility 
� Click on the menu item File->Open COM Port… or speed button Open on 

the tool bar. A COM port selection dialog appears.  Please see 6.1.3 for 

how to connect Bluetooth virtual COM port. For example, Widcomm 

software sets up Bluetooth virtual COM port COM5.  

 

 

 

 

 

 

� Select the RIGHT virtual COM port Phone Base connected. Click OK 

button. Utility starts to retrieve Phone Base’s settings. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.1.3. View Settings 
After retrieving completed, Phone Base’s device name and PIN code will be 
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shown by default. Menu View enables you to view all the settings (View->All) 
or just to choose to view the items you’re interested in (for example, 

View->Missed Calls). 
 

 

 

 

 

 

  

 

 

Click on menu item View->Refresh or speed button Refresh on the tool bar 

or press F5 will restart retrieving the settings. 

 
3.1.4. Change Settings 
Menu “Tools” provides the functionalities about changing the settings.  

 

 

 

 

 

 

 

 

 
 

� Change PIN Code 
There are two PIN codes in Phone Base, one is for active pairing, the other is 
for passive pairing. 
 
Active pairing means Phone Base looks for the nearby devices and initiates 
the pairing process. It is used in Bluetooth headset or hands-free. 
 
Passive pairing means other device initiates the pairing process and Phone 
Base is just waiting to be paired. It is used in CTP handset. 
 

11



The default PIN codes are both “0000”. You may need to change it to meet 
your CTP handset or headset/handsfree device’s PIN code. 
 
Steps: 
� Click on the menu item Tools->PIN Code or speed button PIN. A “Pin 

Code” dialog appears. 

� Type in the required PIN code in the edit box. The upper is Pin code for 

active pairing, the lower is for passive pairing. 

 

Note: Because phone base supports two different types of devices: CTP 

handset and headset/hands-free, it needs separate code for each type. 

The upper Pin code is for Bluetooth headset/hands-free, the low is for 

CTP handset. 

� Click Save button.  
 
 
 
 
 

 

 
 
Note: After you set any item and pressed Save/Delete button, there comes a 
confirmation dialog telling whether configuration has been set successfully, 
just click the OK button. 
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� Enter calling card number 
 
You can store 2 calling card numbers. 
 
A typical calling card may include four items:  
� Local access number 

� Language selection 

� Card number  

� Password 
The dialing instruction in your calling card may ask you to dial local number 
first, followed by language selection. Then you need to key in card number 
ended with “#” key and password ended with “#” key. After that, you dial 
the number that you want to call.  
 
To facilitate your dialing, you can store the long string of calling card 
number in Phone Base. When you need dial a call through your calling card, 
just enter “#”(using the 1st calling card) or “##”(using the 2nd calling card) 
before your phone number to dial.   
When a pause is needed, type in character “P”. Each “P” represents 
one-second pause. 
 
In stead of calling card number, you can also store any frequently used 
numbers to facilitate your dialing. 
 
Steps: 
� Click on the menu item Tools->Calling Cards or speed button Cards. A 

“Calling Cards” dialog appears. 

� Type in the each four items, when a pause is needed, type in character 

“P”. You can also type your number directly in the edit box below “New 

Calling Card to Save:”. 

� Click Save button. 
 
Example: 
Suppose that you are in office and you need to press “0” to get the outside 
line. In a calling card, the access number is 11122, language selection is 1 
for English, 2 for Spanish. The card number is 3333-4444-5555+”#” and the 
password is 6666+”#”.  
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Here is an example to store this calling card number: 
Access Code: “0P11122PP” 
Language: “1PP” 
Card No.: “333344445555#P” 
PIN No: “6666#” 
 
 
 
 
 
 
 
 
 
 
 
 
 
� Edit missed call list 
Phone Base can record missed calls, dialed calls and received calls. Each call 
category can store up to four numbers. 
 
Steps: 
� Click on the menu item Tools->Missed Calls or speed button Missed. A 

“Missed Calls” dialog appears. 

� Select and edit a missed call number. 

� Click Save button.  
 
Note: To allow you to edit the missed calls is to facilitate your dialing from a 
Handsfree device that can read missed calls from Phone Base such as Sony 
Ericsson HBH-200. 
 
 
 
 
 
 
 
 
 
 
 
 

14



� Delete the Bluetooth address of paired devices 
Steps: 
� Click on the menu item Tools->Paired Devices or speed button Paired. A 

“Paired Devices” dialog appears. 

� Click the Delete button on the right of a particular device’s address if 

you want to remove this pairing. 
Note: After you deleted the paired device, you need to do the paring again if 
you want to use such device again. 
 
 
 
 
 
 
 
 
 
 
 
� Change Device Name 
You can change Phone Base‘s local name. The name length is limited to 31. 
The default name is “Phone Base”. 
� Click on the menu item Tools->Device Name or speed button Name. A 

“Device Name” dialog appears. 

� Type in a new name in the edit box.  

� Click the Save button. 
 
 
 
 
 
 
 
Note: Non-alphanumeric letters are restricted when typing in the edit boxes. 
For example, you can’t type in “$” in the edit boxes. And there are also 
length limit for the settings. 
 
� Reset Settings 
When you encounter any problem and need to restore the settings back to 
the default values, click on menu item Tools->Reset Settings. This will clear 
the call lists and paired device information and the PIN code swill be “0000”. 
Note: Be careful to use this function. 
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� Change Parameters for Dialing 
There are 3 parameters for dialing. 
� Dial tone wait before dialing (in seconds, range: 1-255, default: 2) 

� Pause time (in seconds, range: 0-255, default: 1) 

� Tone duration in DTMF dialing (in milliseconds, range: 50-255, default: 

95) 

Click on the menu item Tools->Advanced…. A “Dialing Parameters” dialog 

appears. Only digits are allowed. 
Note: Be careful to use this function. If you can’t dial normally after these 
parameters changed, please try the default values. 

 
 
 
 
 
 
 
 
 
 
 
 
If there appears a dialog like below, it means you entered invalid values for 
those parameters. Please note the ranges. 
 
 
 
 
 
 
 
� Upgrade Firmware 
The firmware in the phone base is upgradeable. However, it is strongly 
recommended that this procedure is done by skilled technical people. 
Caution: Be very careful to use this function. Upgrading firmware is at your 
own risk.  When upgrading firmware fails for some reason, the unit will not 
work at all. 
 
� Click on menu item Tools->Upgrade… 

� It lets you choose a .bin file (must be the bin file that your manufacture 
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provides) and starts upgrading after you assure to do it. 

 
 
 
 
 
 
 
 
 
� After upgrading succeeds, Phone Base will reboot and you need to 

reconnect it if you want to do configurations again. 

 
 
 
 
 
 
 
 
Note: When there appears a dialog l
firmware has been partially updated
Phone Base power on and try upgrad
Phone Base power on. Otherwise Ph
again. 
 
 
 
 
 
 
 
 

 
3.2. CONFIGURE WITH REGULAR
 
Bluetooth Phone Base may need to 
be properly used.  
 
Before configuration, a regular telep
Phone Base.  
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ike below during upgrading, it means the 
 but not finished. You should keep 
ing again. It’s VERY IMPORTANT to keep 
one Base will not be able to run normally 
 TELEPHONE 

be configured before they can 

hone shall have been plugged into 



 
You can:  
� Change PIN code 
 

3.2.1. Preparation 
 
� Turn the Slide Switch to the Cfg. position. 

� Pick up the phone handle and Press * key twice.  

You will hear two short tones. That means Phone Base has entered into 

the configuration mode.  

Note: Only after you hear the two short tones, you are able to do 

configurations successfully. In case you do not hear the right tones, 

repeat pressing * key.  
 

3.2.2. Start Configuration 
 
After entering into the configuration mode (refer to 3.1.1), 

 
 

� Change PIN 
There are two PIN codes in Phone Base, one is for active pairing, the other is 
for passive pairing. 
Active pairing means Phone Base looks for the nearby devices and initiates 
the pairing process. It is used in Bluetooth headset or handsf-free 
Passive pairing means other device initiates the pairing process and Phone 
Base is just waiting to be paired. It is used in CTP handset. 
 
The default PIN codes are both “0000”. You may need to change it to meet 
your CTP handset or headset/handsfree device’s PIN code. 
 
Index of the Pin code for active pairing is 0. 
Index of the Pin code for passive pairing is 1. 
 
Press 0*, then the PIN code index: 0* (for active pairing) or 1* (for passive 
pairing), then the PIN code you want to set, after that, press * key twice at 
the end. 
 
Note: After you pressed the end **, you will hear a confirmation tone, a long 
tone means configuration success, a short tone means a failure. 
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Example: 
If you want to set the PIN code for active pairing as “1234”, enter 
**0*0*1234**. 

 
3.2.3. After Configuration 
Note: After configuration completed, it’s IMPORTANT to turn the Slide 
Switch back to the Std. position.  
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4. USING BLUETOOTH PHONE BASE 

 
 

Before using your Bluetooth CTP phone or hands-free/headset to 
make/receive calls, you have to pair it with phone base first. 
But with CTP phone it’s not necessary to pair first. 

 
4.1. USING WITH BLUETOOTH CTP HANDSET 
Again, your mobile/PDA/smart phone shall support Bluetooth Cordless 

Telephony (Terminal role) or Handsfree (Hands-Free unit role) Bluetooth 

profile. It is called “CTP handset”. 
 

4.1.1. Connect Phone Base 
 
� Start searching neighborhood Bluetooth devices from your CTP handset.  

Please refer to the user’s guide of your CTP handset for details. 

� Select “Phone Base” from your CTP handset found device list and try to 

pair with it. When PIN code is asked, type in the same Pin code that 

Phone Base sets for passive pairing. The default PIN code is “0000”. 

Please refer to the user’s guide of your CTP handset for details. 

 
4.1.2. Answer a call 
 
When there’s an incoming call, Phone Base rings. The blue LED stays on. You 
may hear audio tone in CTP handset.  
Press Accept key in your CTP handset to answer the call. The blue LED and 
the orange LED both stay on during the call. 
Press Reject key to hang up the call. 
 

4.1.3. Make a call 
 
Making a call through Phone Base is just like you making a call by cordless 
phone.  
Please refer to the user’s guide of your CTP handset for details. 

 
4.2. USING WITH BLUETOOTH HEADSET 
Bluetooth Headset shall support Headset (Headset role) Bluetooth profile. 
Some new headsets also support Handsfree (Hands-Free unit role) Bluetooth 
profile such as Sony Ericsson HBH-200, Nokia HS-3W. If you use such a headset, 
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please refer to Section 4.3. 
 

4.2.1. Pair with Headset 
 
The default PIN code in Phone Base is “0000”. If the PIN code in your 
Headset is not “0000”, please go to Section 3 for how to change PIN code.  
 
a) Set your headset in pairing mode.  

Please refer to the user’s guide of your Bluetooth Headset for details. 

b) Press the Mode button (less than 5 seconds) and the blue LED will flash.  

c) Phone Base begins looking for nearby headsets. After several seconds, the 

blue LED stops flashing. If pairing succeeds, your headset LED or tone 

shall indicate that it has been paired with some device. 

 
Note: To avoid Phone Base pairing with unintended device, make sure no 
other headset or other Bluetooth device is in the neighborhood. 
 

4.2.2. Answer a Call 
 
When there’s an incoming call, Phone Base rings. The blue LED stays on. 
You may hear audible tone in the headset.  
Press Talk key in your headset to answer the call. The blue LED and the 
orange LED both stay on.  
Press Talk key again to hang up the call. 
 

4.2.3. Make a Call 
 
� Attach a regular telephone set to Phone Base.  

� Press the Talk key in your headset. (Some Bluetooth headsets may not 

support this feature.) The blue LED and orange LED both stay on. 

� Pick up the phone handle and dial a number. You will hear dial tones in 

the headset. 

� Put back phone handle and use the Headset to talk. 

� Press Talk key again to hang up the call. 

4.3. USING WITH BLUETOOTH HANDSFREE DEVICES  
Handsfree devices shall support Handsfree (Hands-Free unit role) Bluetooth 
profile. Example of such device is Bluetooth Car-kit Handsfree. Some 
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Bluetooth Headsets such as Sony Ericsson HBH-200, Nokia HS-3W also support 
this profile. 
 

4.3.1. Pair with Handsfree Device 
 
The default PIN code in Phone Base is “0000”. If the PIN code in your 
Handsfree is not “0000”, please go to Section 3 for how to change PIN code.  
 
� Set your Handsfree device on pairing mode.  

Please refer to the user’s guide of your Handsfree device for details. 

� Press the Mode button (less than 5 seconds) and blue LED will blink.  

� The Phone Base begins looking for nearby Handsfree devices. After 

several seconds, the blue LED stops flashing. If pairing succeeds, your 

Handsfree LED or tone shall indicate that it has been paired with some 

device. 

 
Note: To avoid Phone Base pairing with unintended device, make sure no 
other Handsfree or Headset or other Bluetooth device is in the 
neighborhood. 
 

4.3.2. Answer a Call 

When there’s an incoming call, Phone Base rings. The blue LED stays on. You 
may hear audible tone in Handsfree.  
Press Accept key in your Handsfree to answer the call. The blue LED and the 
orange LED both stay on.  
Press Reject key to hang up the call. 
 

4.3.3. Make a Call 
 
Your hands-free shall have a dialing keypad in order to make a call. Some 
headset with LCD which can show caller ID might be able to make a call. 
 
There are two ways to make a call:  
a) Same as the way in Make a call when using headset 

Please refer to Section 4.2.3. 

 

b) Dial the desired number in your Handsfree 
Please refer to your Handsfree device’s user’s guide for more details. 
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Here we use Sony Ericsson HBH-200 as an example. 
� Press Accept key on the HBH-200. HBH-200 will connect the Phone Base 

and reads its phone list.  

� Note: Phone Base supports 4 dialed calls, 4 received calls and 4 missed 

calls. 

� Press Volume Up or Volume Down key to select the number you want to 

dial. (You can also use the Configuration Utility to edit the number you 

want to dial.) 

� Press Accept key to dial out the call. The orange LED will stay on and 

blue LED will flash. 

� Press Reject key to hang up the call. 
 

 
 

4.4. WHEN PHONE BASE IS PAIRED WITH TWO OR MORE DEVICES 
 
Phone Base stores a paired device list. It can be paired with up to 7 
Bluetooth devices.  
 
Your CTP handset shall first connect to Phone Base before you can receive 
alerts when there is an incoming call. 
Please refer to the user’s guide of your CTP handset for details. 
 
When there is an incoming call, Phone Base will try to connect the paired 
devices. 
 
The call will be routed to the first device that accepts the call. 
 
Note: When you paired the 8th device, the least used/paired device will be 
deleted automatically from the Phone Base’s paired device list. 

 
4.5. USING CALLING CARD 
 
You need to have a CTP handset or hands-free with dialing keypad in order 
to use calling card. 
 
Before using calling card, you need to store calling card numbers first. 
Please refer to Section 3 for more details. 
 
Press “#”(using the 1st calling card) or “##”(using the 2nd calling card) first 
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before you dial the desired number. Phone Base will dial the calling card 
number first before your call number. 
 
For example, you want to make a long distance call to 111-1234-5678. 
Dial #11112345678 in your CTP handset, the handset will send out calling 
card number and then 11112345678. 
 
Please refer to Section 4.1.3 or 4.3.3 for more details about how to make a 
call with CTP handset or Handsfree devices. 
 
Note: Making calls using telephone set (the way described in Section 4.2.3) 
will not work because the telephone set bypasses the control unit inside 
phone base. Hence calling card number will not be dialed out. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

24



4.6. OPERATION MODE 
 

Phone Base has five different modes that are indicated by the orange LED 
and the blue LED in various status.   
Table below lists the LED status in different modes. 
 

LED Status 
Mode Orange 

LED 
Blue LED Remark 

Ready Off Off Power up 
Active Pairing Off Blink Press Mode button (less 

than 5 seconds), Phone 
Base will looking for 
nearby Bluetooth 
Headset or Handsfree 
device 

Ring Off On When there is an 
incoming call, Phone 
Base rings 

Talk On On Press Talk/Accept key in 
Headset or Handsfree 
device 

Upgrading Firmware Blink Blink Using PC utility to 
upgrade firmware when 
new firmware is released 
by manufacture 

Reset Settings Blink 
Once 

Off Press Mode button (more 
than 5 seconds), Phone 
Base will reset PIN codes 
to “0000” and clear the 
call lists and pairing 
devices 
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5. TROUBLESHOOTING 
 

1.  Symptom: 
When Phone Base rings, my Headset or Handsfree can not answer the call 
Answer: 

a) Make sure that your device is turned on. 

b) Make sure that the phone line is in right phone jack marked Line 

c) Make sure that your device is within the coverage of phone base. 

d) Make sure that your device has been paired with Phone Base. Please refer 

to Section 3. 
 

 
2.  Symptom: 

When I use the way described in Section 4.2.3 to make a call, I can’t 
hear any dial tone. 

Answer: 
a) Make sure that the slide switch in on the Std. Position 

b) Make sure your phone line works well 
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6. APPENDIX 
 

 
6.1. APPENDIX A 
 

 

6.1.1. Install Widcomm Software 
 

NOTE : This software is needed only if you have a USB Bluetooth Dongle, 
and you want to use it to communicate with Bluetooth Phone Base. Skip 
this section if you are not using it. 

 
 

This software is not included in our Bluetooth Phone Base package. We 
assume you already purchased a Bluetooth USB dongle product and it 
already bundled with this software. We also assume you already installed 
this software in your PC. If NOT, please read the following messages to 
learn how to do it. 

 
 

This Widcomm software is accompanied with the Bluetooth USB dongle 
product you purchased. Try to download the latest revision. 

 
 

There are other Bluetooth services that Widcomm software provides. We 
will only emphasize on the Bluetooth Serial Port service, and you may try 
to know other services by yourself. 

 
 

The following steps tell you how to 
install the Widcomm software. 

 
 

Step 1 : Find Setup.exe from the 
given Widcomm software CD or 
downloaded install files, and double 
click on it to install Widcomm 
Bluetooth Software. It opens the 
InstallShield Wizard dialog box, then 
click Next. 

 
 
 
 

Step 2 : Accept the software license 
agreement. Click Next. 

 
 
 
 
 
 

27
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Step 3 : Select destination folder, 
you can choose the default or 
change to your favorite. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 4 : Click Install to start the 
installation. 

 
 
 
 

If you have not plugged in Bluetooth 
Dongle onto your PC before, one 
reminding window will show up to 
ask you to plug in it before installa- 
tion can be finished. 

 
 
 
 

Step 5 : Click OK to continue the 
installation. 

 
 
 
 
 
 
 
 
 

Step 6 : Installation is complete . 



 

 

 

My Bluetooth Places      should 
appear on your desktop and a similar 
icon also appears on the lower right 
corner of your screen. You can  
double click    on desktop or right 
click     on the lower right hand 
task bar of your screen, then click 
“Explore My Bluetooth Places” menu 
to start ”My Bluetooth Places” 
program. 
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6.1.2. My Bluetooth Place 
 
Step 1 : 

 
 

Method 1 : 
Double click      on your desktop. 
Click Folder on the toolbar. Folder 
window will appear on left side of 
your screen. 

 
 
 
 
 
 
 
 
 

Method 2: 
Right click      on the lower 
right hand corner of your screen. 
Select Explore My Bluetooth Places. 

 
 
 
 
 
 
 
 
 

Two folders appear on the window. 
They are : 

 
 

Entire Bluetooth Neighborhood 
and My Device. 

 
 
 
 
 
 
 

Step 2 : 
Click Entire Bluetooth Neighborhood 
to search for devices available to 
you. Once Bluetooth devices are 
detected, their icons together with 
device names will be displayed on 
the screen. 

 
 

 



You also may start a search for 
devices by clicking Bluetooth from 
the toolbar. 

 
 
 
 
 
 
 
 
 
 
 

Step 3 : 
In this example, one Phone Base is 
found in your Bluetooth 
neighborhood. 

 
 
 
 
 
 
 
 
 
 

 

The “My Bluetooth Places” program provides an easy way to find different 
application services through Bluetooth connections. A variety of Bluetooth 
services and explanations can be found in the “Help” file of the 
“My Bluetooth Places” program. 
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6.1.3. Connect the Bluetooth Virtual Com 
 

Step 1 : 
Double click      on your desktop. 
Click Folder on the toolbar. Folder 
window will appear on left side of 
your screen. 

 
 
 
 
 
 
 
 
 

Step 1 : 
Click Bluetooth from the toolbar, 
then click Search For Devices to 
search for Bluetooth devices avail- 
able to you. Once Bluetooth devices 
are detected, their icons together 
with device names will be displayed 
on the screen. 

 
 
 
 
 
 
 

Make sure your Phone Base is in 
Configuration mode. Please refer to 
Section 4.5 for how to enter 
Configuration mode. You may find 
your Phone Base named as “Phone 
Base xxxx”. “xxxx” is the last four 
digits of Phone Base’s address.  
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Right click on device name “Phone 
Base xxxx”, then click on Discover 
Available Services. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can find the services that Phone 
Base provided are “Bluetooth Serial  
Port” and “Voice Gateway”. 

 
 
 
 
 
 
 
 
 
 
 
 

Right click on the service 
“Bluetooth Serial Port”, then click 
on Connect to Bluetooth Serial 
Port. 

 
 
 
 
 
 
 
 
 
 
 

Pin code will be asked if it’s your 
first time connecting Phone Base. 
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Type in the PIN code for passive 
pairing. It’s “0000” by default. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A connection between local PC 
Bluetooth Dongle and Bluetooth 
Phone Base will be built. 

 
 
 
 

An icon         will be displayed  
to inform you that a successful 
connec- tion has been created, and 
blue LED on Bluetooth Phone Base will 
on. 

 
 

 
 
Click the device name “Phone Base 
xxxx”, (Select Details in menu View) 
Widcomm software will inform you 
that a virtual COM port (COM5 in this 
case) is used by your PC (USB 
Bluetooth Dongle) to communicate 
with the Bluetooth 
Phone Base. 

 
 

Now the Bluetooth virtual COM port  
has been connected. You can launch  
the Phone Base utility from PC and do c
 
 

 

onfigurations. 
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6.2. APPENDIX B  
Specifications: 

 
 

Product Name Bluetooth Phone Base 

Certification FCC, CE, BQB 

Standard Bluetooth v1.2 

Bluetooth Profiles Gateway in Cordless Telephony Profile (CTP) v1.1 
Audio Gateway in Headset profile v1.1 and 
Hands-Free profile v1.0 

Frequency Band 2.4~2.4835GHz unlicensed ISM band 

Spread Spectrum FHSS (Frequency Hopping Spread Spectrum) 

RF Output Power Class 1; 13dBm typical 

Antenna External antenna 

Working Distance Up to 40m in free space (used with class 2 headset) 

Sensitivity <-88dBm at < 0.1% BER Power  

Input Power 7.5VDC 

LEDs Indicator 3 LED’s: Power / Bluetooth status/ phone line status 

Phone Feature 1. Two modes of Caller ID: FSK and DTMF 

2. Dialer 

3. Store up to 12 phone numbers 

Windows Utility 1. Configure PIN 
2. In dialer function, store access code and password 
3. View/Edit call list  
4. Change local name 

Phone Jack Two RJ-11, one for line in, another for extension 

Configuration Telephone set or Bluetooth enabled PC 

Multiple Devices Support up to 7 handsets and headsets 

Firmware Upgrade Upgrade by Bluetooth enabled PC 

Operating Temperature  0 ~ +60℃ 

Storage Temperature -10 ~ +70℃ 

Humidity 5 ~ 90% (non-condensing) 

Size 113(L) x 92(W) x 35(H) mm 
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Safety Guide: 
� Read and follow all instructions and warnings provided. 
� Save these instructions for future use. 
� When service or replacement of parts is required, ensure work is done 

by a qualified technician. 
� Do not use this unit near water or in a rainy/moist environment. 
� Use supplied cables only. 
� Do not attempt to service this product yourself. Doing so will ex- 

pose you to various hazards including dangerous voltage. 
� This unit is suitable for a 110V to 230V AC power supply (Auto- 

detect). 
� Disconnect the power cable (pull plug) and USB cable in the following 

situations : 
� In the event of service. 
� Power cable/plug becomes damaged. 
� Unit is exposed to excess moisture/rain 
� Unit has been dropped. 
� Unit is being cleaned. 

� Unit must be used with adult supervision at all times. Children must 
not be allowed to handle any of the cables. 

� Never insert any objects other than CDs in the trays. 
� Never insert any objects through ventilation holes. 

 
 
 

Remember ! 
Any electrical equipment is hazardous if handled improperly. 
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F CC COMPLIANCE 

This device complies with Part 15 of the FCC Rules. Operation is subject 
to the following two conditions: (1) This device may not cause harmful 
interference, and (2) This device must accept any interference received, 
including interference that may cause undesired operation. 

 
 
 

Federal Communications Commission (FCC) Statement 
 
This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in 
a residential installation. This equipment generates, uses and can radiate 
radio frequency energy and, if not installed and used in accordance with 
the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference 
will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be deter- 
mined by turning the equipment off and on, the user is encouraged to try 
to correct the interference by one or more of the following measures: 

 
 

� Reorient or relocate the receiving antenna. 
� Increase the separation between the equipment and the receiver. 
� Connect the equipment to an outlet on a circuit different from 

that to which the receiver is connected. 
� Consult the dealer or an experienced radio/TV technician for  

help. 
 
 
 

Warning: 
To meet FCC requirements, a shielded power cord is required in order to 
prevent interference. It is essential that only the supplied power cord is to 
be used. Use only shielded cables to connect I/O devices to this equipment. 
You are cautioned that changes or modifications not approved by the party 
responsible for compliance could void your authority to operate the 
equipment. 
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One Year Limited Warranty 
 
 
 

� This device is guaranteed against manufacturing defects  
for one full year from the original date of purchase. 

� This warranty is valid at the time of purchase and is non-transferable. 
� This warranty must be presented to the service facility 

before any repair can be made. 
� Sales slip or other authentic evidence is required to validate war- 

ranty. 
� Damage caused by accident, misuse, abuse, improper storage, 

and/or uncertified repairs is not covered by this warranty. 
� All mail or transportation costs including insurance are at the ex- 

pense of the owner. 
� Do not send any product to service center for warranty without a RMA 

(Return Merchandise Authorization) and proof of purchase. Ensure a  
trackable method of delivery is used (keep tracking number). 

� Warranty is valid only in the country of purchase. 
� We assumes no liability that may result directly or indirectly 

from the use or misuse of these products. 
 
 

IMPORTANT 
" This warranty will be voided if the device is tampered with, improperly 
serviced, or the security seals are broken or removed" 
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